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The following tutorials explain how to correctly
use Hair and Cloth on your models to accomplish
specific results. The Hair tutorials refer to applying
different types of hair and fur, while the Cloth
tutorials demonstrate the basic workflow to create
pieces of clothing, and then tailor them to your
model.

Features Covered in This Section

• Adding the Hair and Fur modifier

• Using a sub-object level to control hair
placement

• Modifying hair settings, including material
properties

• Rendering hair

• Using the Garment Maker

• Applying the Cloth modifier

• Locking points on the cloth

• Adding space warps and collision objects to the
cloth

• Running a Cloth simulation

• Adjusting fabric properties

Files for This Section

All the files necessary for this tutorial are provided
on the program disc in the \tutorials directory.

Before starting the tutorials, copy the \tutorials
folder from the disc to your local program
installation.

Hair

Hair Tutorials

The tutorials included in this section walk you
through a variety of methods for using Hair.

Features Covered in This Tutorial

• Adding the Hair And Fur modifier

Hair and Cloth
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• Using a sub-object level to control hair
placement

• Modifying hair settings, including material
properties

• Rendering hair

Tutorial Files

All the files necessary for this tutorial are provided
on the program disc in the \tutorials\hair
directory. Before starting the tutorials, copy
the \tutorials folder from the disc to your local
program installation.

Creating a Centurion Helmet
Add the Hair And Fur modifier to the helmet:

1. Open helmet_hair_start.max from your
\tutorials\hair folder. This scene contains two
mesh objects named Head and Helmet.

2. Select the Helmet object, and then go to the
Modify panel and apply the Hair And Fur
modifier. Hair And Fur is a world-space
modifier (WSM).

Hair emanates from the entire helmet.

3. The hair should grow only on selected
portions of the helmet, so on the Selection

rollout, click Polygon to go to the Polygon
sub-object level.

4. Turn on Ignore Backfacing.

5. Select the polygons in the groove at the top of
the helmet.

This is easiest to do in the Top viewport:
use Arc Rotate to make sure you’ve selected all
these polygons. When the selection is complete,
press Shift+Z to restore the original Top view.
(You might have to press Shift+Z more than
once.)

Selecting the crest polygons

Tip: You can use Ctrl +click (or drag) to add
or remove polygons from the selection, and
Alt +click (or drag) to remove them.

6. On the Selection rollout,
click Update Selection.

The hairs now emanate only from the selected
polygons.
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Hairs growing from the crest only

Modify the Hair general parameters:

1. Scroll down to the General Parameters rollout.

2. Change the hair count to 10000.

3. Reduce Hair Segments to 4. This value is the
number of segments created along the length of
each hair. Shorter hair needs fewer segments;
longer hair needs more segments. Lowering the
number of segments also reduces the amount
of time it takes to render the scene.

4. Change the Rand(om) Scale value to 0.0.

For this example, the helmet hair is all the same
length, without any random scaling.

5. Set the Root Thick and Tip Thick values both
to 2.0 so that the hairs are the same thickness
along their entire length.

Next you’ll change the frizz and material
properties of the hair.
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Modify the Frizz and Material Properties of the
helmet crest:

1. Open the Frizz Parameters rollout.

2. Set the Frizz Root and Frizz Tip values to 10.0.

3. Open the Material Parameters rollout.
4. Select a bright, saturated red for the Tip Color

and black for the Root color.

5. Reduce both Hue Variation and Value Variation
to 5.0.

Because this is dyed hair, its color and texture
are more uniform than natural hair. We want to
add a bit of variety, but not much.

6. Leave the Mutant % value at 0.0.

Mutant hairs are randomly selected and receive
the color assigned. Mutant hairs are present in
natural hair; as we age, we have more and more
mutant gray or white hairs. However, the foot
solder’s helmet plume will not age (they used
dyed horsehair), so you’ll leave the mutant hairs
out for now.

Render your scene to view the hair:

The Hair And Fur modifier requires at least one
spotlight in the scene to render shadows.
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1. From the right-click quad menu, choose
Unhide All to unhide the lights in the scene.

Two omni lights for general lighting and one
spotlight for the Hair And Fur modifier appear.
The spotlight is set to render shadows.

A Hair And Fur render effect is necessary to
render hair, but this is added automatically
when you first apply the Hair And Fur modifier
to an object in the scene. Also, by default the
render effect is set to automatically use all
spotlights in the scene to illuminate the hair, so
no don’t need to take further action to adjust
the lighting.

You can now render your scene.

2. With the Perspective viewport active, render
your scene (press F9 ).

Note: You can render hair only in a Perspective
or Camera viewport.

Your centurion helmet should look something
like this:

Rendered image of the helmet

Recombing the Helmet Crest of
Hair

In this lesson you’ll learn how to style the hair
using the Recomb From Splines tool.

1. Continue from the previous lesson or open
recomb_helmet.max.

2. Before you begin to draw the splines, turn on
the Snaps Toggle (press S ) so that the start of
the splines begin at the roots of the hair. Also,
right-click the Snaps Toggle button to open the
Grid And Snaps Settings dialog, and on the
Snaps panel, turn off Grid Points and turn on
Face. Close the dialog with the X button in the
upper-right corner.

3. Starting at the front of the helmet, draw Line
splines away from the head as illustrated below.
Hair requires that all the splines are part of the
same object, so after you draw the first spline,
turn off the Start New Shape check box on the
Object Type rollout.
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Spline object to use for recombing

4. Select the Line object to make sure all the
splines are part of the same object. If they are
not, select the first line, go to the Modify panel,
and at the Spline sub-object level, use Attach to
attach the other lines.

5. Select the Helmet object, and on the Tools
rollout, click Recomb From Splines. In a
viewport, click the spline object.

The hair now follows the shape of the splines.

• Render the Perspective viewport to view the
new hair.

Hair recombed by splines

Adding Facial Hair to the Centurion

Now that you have the helmet ready to go, you’ll
add hair to the centurion’s face.

1. Continue from the previous lesson, or open the
file recomb_helmet_splines.max.

2. Apply the Hair And Fur modifier to the head.

3. Go to the Polygon sub-object level. Make sure
Ignore Backfacing is turned on, and select the
polygons at the base of the chin.

As with the helmet, Arc Rotate can help
you locate the polygons you need, and once
you’ve made the sub-object selection, Shift+Z
will undo the viewport changes.

4. Click Update Selection.
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Hair as a goatee, with chin polygons selected

Use preset hair values:

1. On the Tools rollout, click Load in the Presets
group.

The Hair And Fur Presets dialog appears.

2. Double-click the “clumpy-wet-brown” preset
to apply it to the polygons.

3. Adjust the Perspective viewport so it shows a
better view of the chin, and then render it.

You now have fine, spiky hair growing from the
chin.

The goatee before styling

Style the goatee:

1. Open the Styling rollout and click Style Hair
to turn it on.

A green brush gizmo appears in viewports.
In the active viewport, the brush appears as a
circle, but it is actually a cylindrical region, as
you can see in inactive viewports.

Orange guide hairs also appear in the
viewports, among the actual hairs. When you
style hair, you are styling the guides. There are
fewer guides than hairs, so this method saves
performance time.

Tip: The Guides can be easier to see in
viewports if you turn off Toggle Hair in the
Styling rollout’s Utilities group.

2. Make sure the brush is large enough to
encompass the goatee. If you need to change
its size, you can use the slider in the Styling
group (below the Ignore Back Hairs toggle), or
you can hold down Shift+Ctrl and drag the
mouse.

3. Click the Translate button to turn it
on, position it over the goatee, and drag to
straighten the hairs so they point away from the
chin.
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The Front and Left viewports are the easiest to
use for this adjustment.

Goatee translated downward and away from the chin

4. Click the Clump button to turn it on. In
the Front viewport, place the brush over the
goatee and then drag toward the right to move
the guide hairs together until they come to a
point (see the illustration below).

5. You might want to repeat the two preceding
steps until you get a result you like.

6. When you are happy with the results, render
the Perspective viewport.

The goatee after translating and clumping

The hair still frizzes out a bit too much at the
tips.

Fix the frizz value:

• Go back and change the Frizz Tip value to 0.0.
Render the scene again to view the changes.

The goatee with tip frizz removed

Grooming a Dog

In this tutorial you’ll use Hair to add fur to a dog
model, and then groom the fur. The tutorial also
covers preparing the model for automatically
growing fur of different lengths by adjusting
polygon sizes.

Set up the lesson:

• Load the file dog_groom_start.max. This is
located in the \tutorials\hair\ folder.

This scene contains a cartoon dog model.
The dog was created using the box-modeling
method, and was then mesh-smoothed. This
automatically creates smaller polygons where
the hair should be shorter, such as on the legs.

Apply Hair and Fur and choose a preset:

1. Select the dog model, and then go to the Modify
panel.
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2. From the Modifier List drop-down >
World-Space Modifiers category, choose Hair
And Fur (WSM).

The hairs appear as brown lines emanating
from the dog model.

Begin grooming the fur:

1. Open the Styling rollout, and click Style Hair
to turn it on.

A large number of orange hair guides appear
in the viewports. By default, all the guides are
standing perpendicular to the mesh surface,
and are all the same length.

At the start, all the guides stick straight out.

2. In the Utilities group, click the Attenuate
button.

Attenuated guides

Attenuate makes the length of hair guides
proportional to the size of the polygons they
grow from. Attenuate is a useful tool in this
case, because most dogs have shorter hair in
areas with higher detail, such as the head and
legs.

Use the Translate tool to brush the fur:

1. Activate the Left viewport, and press Alt+W
to maximize it.

When you turn on Style Hair, the
Hair Brush and Translate tools are on by default.
You’ll use these to begin grooming the dog.

2. Increase the size of the brush until it is about
a third the size of the dog. This is about
two-thirds to the right on the Brush size slider
(just below the Ignore Back Hairs toggle).

3. In the Selection group, click the Select
Hair By Ends button to turn it on.

The tip vertices of the hair guides appear in the
viewport.
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This selection option moves hairs by the end
only. The effect is softer than Select Whole
Guide, which is the default.

4. Position the brush over an area you want to
groom, and drag the mouse to groom the fur in
the general direction it should flow, away from
the dog’s face.

Note: Don’t worry if hair appears to penetrate
the surface of the dog. You will fix this in a later
step.

The dog after a first brushing

Because this is a big soft brush, you can get a
fairly smooth transition from one direction to
another. As you continue to groom, make the
brush smaller for fine-tuning the fur.

5. In the Utilities group, click Recomb.

The Recomb tool snaps all the hair that you’ve
just brushed to the surface’s tangent, but it
preserves the hair’s length and overall direction.

Recombing “tames” the guides.

6. Repeat the two previous steps until you’re
happy with the general flow of the fur.

The dog after further grooming and recombing

Scale the fur to adjust its length:

1. In the Styling group, click the Scale tool
to turn it on. Reduce the size of the brush, and
then go around the dog, manually adjusting the
guide lengths. Dragging to the right increases
hair length, and dragging to the left decreases it.

The hair on the ears and legs should be a bit
shorter, and you might want to grow the hair on
the snout and tail out a bit.
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Scale the guides in places where the fur should be
shorter.

2. Click Recomb again.

3. Repeat the previous two steps until you like the
result.

Use the Stand tool to make the hair stand out from
the body:

1. In the Selection group, click Select
Whole Strand to turn this selection mode on
once again. Then in the Styling group, click the
Stand tool to turn it on. Position the brush over
areas of the dog, and drag to the right a bit to
puff the hair away from the body.

Using Stand with the brush pushes the hair
away from the skin.

Use the Stand tool to make the guides stick out more.

Natural fur usually stands out at about 60
degrees from the surface; you can also use the
Translate brush at a side angle to do this. For
this tutorial, you’re modeling a stuffed animal,
so you can stand the hair out a bit more than
might be natural.

2. When you’re satisfied with the grooming, click
Finish Styling to turn this button off.

3. Press Alt+W again to restore the four
viewports.

Adjust the material settings:

This is a toy dog, so you can use unreal coloring to
enhance the effect.

1. Open the Material Parameters rollout..

The scene already contains two spot lights,
both set to cast shadows in the form of shadow
maps. Because the Hair and Fur render effect
uses these by default, the spot lights will
automatically cast shadows from the hair.

2. Set Tip Color to a medium green: R=95,
G=157, B=45.

3. Set Root Color to a slightly darker green: R=61,
G=145, B=45.

4. Set Occluded Amb. to 96.4 and Hue Variation
to 40.0. The fur shouldn’t be too shiny, so set
Specular to 8.365 and Glossiness to 71.28.

Adjust other settings to make the hair like fur:

1. Open the General Parameters rollout. Set Hair
Count to 329000, Hair Passes to 3, and Tip
Thick to 1.0.

Note: These settings make the dog quite furry.
It will take a long time to render, but the results
are good.

2. Open the Frizz Parameters rollout. Set Frizz
Tip to 20.0, and Frizz X/Y/Z Freq. (all three)
to 64.0.
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Render the dog:

Warning: This step takes a long time, so you might want

to skip it. If you do render your version of the dog, plan

on a long break.

• Activate the Perspective viewport, and then
press F9 to render the scene.

The dog in all its furry glory

Styling Hair with a Spline Emitter

Some hairstyles, particularly longer ones, lend
themselves more naturally to spline interpolation
than surface growth. Spline-based hair basically
gives you explicit control inside 3ds Max over a
finite set of guide hairs. When you create hair
with a spline object as the growth source, Hair
creates a guide from each spline in the object.
It then uses these guides as cross-sections to
create hair growth. Essentially, you’re creating a
three-dimensional “sheet” of hair in the shape of
the spline cross-sections.

For success with spline-based hair, keep these
important requirements in mind:

• Hair growth is interpolated between each pair
of successively numbered splines. The best way
to ensure this is to create the splines that serve
as the hair outline as separate objects, and then
attach them all together in the correct order.

• Interpolation between pairs of splines is linear,
so use as many splines necessary to create a
rounded look for your hair.

• The first vertex in each spline serves as the hair
root, so when you create the splines, start at the
base of each hair.

In this tutorial, you’ll create two different spline
objects, both comprising a number of Line splines,
to create a woman’s hairdo. The hairdo will have
bangs in the front, with a flip on the sides and long,
straight hair in the back.

Set up the tutorial:

1. Open the file spline_emitter_start.max.

The scene consists of a simple head mesh and
three shadow-casting spot lights that are hidden
at this time. Instead of using the mesh as a hair
emitter, you’ll create a spline-based outline for
the hair.

2. Select the head in the scene and right-click
it. From the quad menu that appears, choose
Freeze Selection.

3. On the main toolbar, right-click the
Snaps Toggle button to open the Grid And Snap
Settings dialog.

4. The only snaps option that should be on is
Face. As necessary, turn off any other options
and turn on Face.

5. In the Grid And Snap Settings > Options panel,
turn on Snap To Frozen Objects.
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6. Click the close button in the upper-right corner
to exit the dialog, and then left-click the Snaps
Toggle button to turn on snapping to faces.

Create the spline cage for the hair:

In this section you’ll create the splines for the hair.
In that respect, you have to consider the design of
the hairdo and the parting of the hair. The red line
in the following illustration shows where the hair
part will be. You will use it as a base line for the
hair splines as they flow on either side of the head.

The hair part line

1. Go to the Create panel and choose Splines >
Line. Make sure Initial Type and Drag Type are
both set to Smooth.

2. In the Perspective viewport, position the mouse
at the front of the parting line seen above, and
then click to start the spline. Move the mouse
partway down the left side of the head and
click again. Move it farther down and slightly
back, click again, and then move it down and
closer to the front to create a nice flowing curve.
Right-click to end.

The four-vertex spline is not smooth enough to
follow the contours of the head. You will make
the necessary adjustments later but for now,
press F3 to view the scene in wireframe mode..

3. Continue adding splines. Start the next one
a little further back from the first. Likewise
for the third and fourth. Continue around the
back, always placing the spline base points
along the parting line of the hair. use the
following image as a reference.
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Adjust the spline cage

1. Go to the Display panel. In the Hide
rollout, turn on Hide Frozen Objects. This
hides the head object from the scene.

2. Select the first spline you created: Line01,
and then go to the Modify panel.

3. From the Geometry rollout, click the Attach
button.

4. Attach the splines sequentially, moving
clockwise around the head. The sequential
numbering of splines in the spline cage is

very important for the hair modifier to work
properly.

5. Go back to the Display panel and turn off
Hide Frozen Objects.

6. With the spline cage selected, go to the
Modify panel and rename the object Hair.

7. Go to the Vertex sub-object level. Looking at
the top of the head, select all the first vertices
representing the hair roots.

8. Press Ctrl+I to invert the selection.

9. From the main toolbar, choose
the Scale tool and set the scale pivot to Use
Selection Center

10.Scale the selection up so that the splines flow
more naturally around the head.
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11.Adjust the individual vertices so they fit the
shape of the head nicely, floating just above
the mesh. Make the necessary adjustments
to follow the design of the hairdo you have
set yourself to achieve. If necessary, refine the
splines to add vertex control to shape the spline
cage with more detail.

Generate the hair:

1. Continue working on your file or open the file
spline_emitter_hair.max

2. With the Hair object selected, apply a Hair And
Fur (WSM) modifier.

Hair And Fur modifier applied to splines

Adjust the hair settings:

The settings described in the following steps were
arrived at through experimentation. You might
find other settings that work better for your hair,
so feel free to experiment yourself, and revise the
suggested values.

1. Open the General Parameters rollout and set
these values:

• Hair Count =1200

• Hair Segments =25

• Hair Passes =4

• Root Thick =6.0

• Tip Thick =4.0

These settings control the number of hairs,
their curvature, and their size.

2. Open the Material Parameters rollout and set
these values:

• Occluded Amb. =0.0

• Tip Color = dark brownRGB (34,28,13)

• Tip Color = dark brownRGB (29,24,11)

• Hue Variation =15

These settings control the material properties
of the hair, such as color and shininess.
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3. Open the Frizz Parameters rollout and set this
value:

• Frizz Root =80

This setting adds a certain amount of noise to
the root of the hair, making it look denser and
more natural.

4. Open the Multi Strand Parameters rollout and
set these values:

• Count =5

• Root Splay =0.85

• Randomize =15

These parameters add a certain amount of
clumping to the rendered hair.

Render the hair:

• Render the hair in the Perspective viewport.

The final result

If you have time, try rendering the hair from
various angles.

The same hair, rendered in a partial profile

The same hair, rendered nearly from the back

To see our final results, open the scene
spline_emitter_final.max. Your results might
differ significantly; there are many variables in
projects like this.

Also if you have time, try adjusting spline
vertices to further style the hair. Notice that as
you adjust the splines, the display hairs in the
viewports are updated interactively.

Working with Hair Presets

Presets let you save or load the various hair
settings.
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Set up the scene:

• Continue working on your file or open the file
spline_emitter_final.max.

Save your work:

Now that you have adjusted the hair parameters,
you will save a hair preset for later recall.

1. With the Hair object selected, go to the
Modify panel and expand the Tools rollout.

2. In the Presets group, click the Save button.

3. In the dialog that appears, name the preset
Brown_Hair and then click OK.

Load a new preset:

1. In the Tools rollout > Presets group, click the
Load button.

The Hair And Fur Presets dialog appears. The
preset you just saved is displayed in a thumbnail
called Brown_Hair.shp.

2. Double-click the platnumBlond.shp thumbnail
to load that Preset.

3. Render the Perspective view to see the results.
The character now has light blond hair, but the
parameters need adjustment.

Platinum blond hair: default preset settings

Presets are a good way to load hair settings, but
often you need to adjust the preset parameters
to get the effect you are aiming for. In this
case, it looks like the hair ought to be finer and
straighter than the default settings show.

Adjust the preset settings:

1. Change the hair settings as follows:

• General Parameters > Hair Segments =30

• General Parameters > Root Thick =4.0

• General Parameters > Tip Thick =3.0

• Frizz Parameters > Frizz Root =50

• Frizz Parameters > Frizz Tip =0

• Multi Strand Parameters > Multi Strand
Count =4

• Multi Strand Parameters > Root Splay =0.2

2. To test the results, render the Perspective view
again.



750 Chapter 7: Hair and Cloth

Blond hair after adjusting the preset settings

Feel free to experiment with other settings.

Working with Instance Objects

Organic growths such as feathers, leaves, flowers,
and scales have properties similar to hair, and
present similar challenges for modeling. The Hair
And Fur modifier lets you model these objects by
growing instances of an object.

When you work with instances, please keep the
following points in mind:

• You’re creating geometry, even if it is only at
render time, so memory is a limitation on hair
count. For this reason, use an object with a low
polygon count, and a comparitively low Hair
Count.

• The material applied to your growth is inherited
from the growth object, not the instance itself;
only UVs come from the instance.

• The root of the instance, where the 3ds Max
pivot is, will be at the root of where the hair
would otherwise be.

• The shape or grown instances, including their
size, bend, and so on, result directly from the
hair settings, including styling.

• Despite the expression “instance,” objects
created with Hair’s Instance Node tool are not

true 3ds Max instances of the original object:
they do not automatically reflect subsequent
changes to the original. To updated instanced
hairs, you must click the button in the Instance
Node group after you edit the source object.

Set up the tutorial:

1. 1. Open the file instancing_start.max.

The scene consists of a dog model with Hair
applied, and a plane mapped with a leaf image.

Both the dog model and the leaf have already
been textured with the same material.

2. Render the Perspective view.

Dog and leaf both share the same material

Check the leaf object’s pivot point:

• Select the leaf object.

Check that the leaf object’s pivot is at its base,
where it will connect with the dog’s skin.

If the pivot weren’t at the leaf ’s base, you’d need
to go to the Hierarchy panel > Adjust Pivot
rollout, turn on Affect Pivot Only, and then
move the pivot to the proper location.
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Choose the leaf to use as an instanced hair:

1. Select the dog object and open the Tools rollout.

2. In the Instance Node group, click the pick
button (if there is no instance, its label shows
“None”), and then in a viewport, click the leaf
object.

Render the result:

• Render the Perspective view once more.

Leaf applied as an instanced hair

Working with Surface Lock

One of the useful tools Hair offers is the ability to
lock hairs to a surface. This feature allows you to
create features such as a braid as easily as you can

model one. In this tutorial you’ll use the surface
lock feature to create a twist of hair.

Set up the tutorial:

1. Open morph_braid_start.max.

This scene contains three cylinders combined
into a single object named Braid surface, which
morphs into a braid. This braid geometry is
not renderable: its only purpose is to deform
the hair.

2. Select Braid surface and note the hair settings.

When locking hair to a surface, you are actually
locking the guides to the surface, so it’s a good
idea to use low values for the parameters that
spread hair away from the guides; for example,
Random Scale and Frizz. For realistic hair,
set these values a little higher than 0. It is
also a good idea to use a higher-than-usual
Hair Segments value, in order to improve
deformation.

Set the sub-objects that grow hair:

You’ll grow hair from the tops of the cylinders and
then drape it down around the surface.

• At the Polygon sub-object level of the Hair
And Fur modifier, select the top polygons of
each cylinder as shown, and then click Update
Selection.

Top two segments of the hair braid selected
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Align the hair to the braid model:

• On the Tools rollout, click Recomb From
Splines and then pick the Spline Guides object.

The hair aligns to the direction and length of
these splines.

You could easily create these splines from edges
of the geometry, drawing them by hand. Or
you could just create the same hairstyle using
the styling tools and skip the splines altogether.

The next step is to lock the hair to the surface
of the cylinders, which you do in the Styling
rollout.

Lock the hair guides:

1. Change from the Polygon to the Guides
sub-object level.

This also activates the controls on the Styling
rollout.

2. Open the Styling rollout.

By default, all the guide vertices are selected, so
you don’t need to select any.

3. Click the Lock button to turn it on. Now
the hair guide vertices are locked to the Braid
surface object.

Note: In other situations, it might be desirable to
lock only specific parts of the hair to a surface;
for example, to wrap hair around curlers, or
tuck hairlocks behind the ears.

4. Click Finish Styling to turn this button off. This
also exits the Guides sub-object level.

Set up rendering and render the result:

1. In the modifier stack, turn on the Morpher and
Path Deform modifiers.

Note: For animation, the braid mesh can be
skinned to a bone chain, instead of posed with
Path Deform.

2. Go to frame 20.

3. Render the Camera01 viewport.



Copying Hair: Transplants, Wigs, and Toupees 753

The completed braid

If you have time, you can also look at the
scene morph_braid_finished.max. This
scene contains two additional Hair And Fur
modifiers, which model layered growth effects.

Rendering of braid with layered hair

Copying Hair: Transplants, Wigs,
and Toupees

Once you’ve created mesh-grown hair, you can use
a number of ways to move it from one character
or creature to another. This lesson demonstrates
three of them.

Method 1: The Toupee

The “toupee” method is relatively simple. Starting
with mesh-grown hair you get rid of unnecessary
geometry in order to move this hair elsewhere.

1. Open the file toupee_start.max.
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2. Select the head mesh, and then go to the Modify
panel. On the Tools rollout, in the Hairdo
group, click Copy.

This caches the full hair description, including
guides and materials.

Important: If you skip this step, the method will not

work!

3. Go to the Polygon level of the Hair And Fur
modifier.

The polygons selected to grow hair become
visible.

The selection of polygons that grow hair

4. On the Selection rollout, in the Named
Selection Set group, click Copy.

The Copy Named Selection dialog appears.

5. In the dialog, click to highlight the tophead
selection set, and then click OK.

6. On the modifier stack, expand the Editable
Mesh entry. Click Yes to dismiss the warning
that appears. Click the Polygon entry to go to
that sub-object level.

7. On the Selection rollout, under Named
Selections, click Paste.
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The hair polygon selection pasted to the editable mesh

8. Choose Edit > Select Invert to invert the
selection.

The polygon selection inverted

9. Press Delete to delete the polygons that don’t
grow hair.

After Delete, only the hair-growing polygons remain.

10.On the modifier stack, highlight the Polygon
level of the Hair And Fur modifier once again.

Your selection has probably been scrambled a
bit.

After you edit the mesh, the poly selection in the Hair
modifier is scrambled

11.Press Ctrl+A to select all the polygons. Then
on the Selection rollout, click Update Selection.
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The hair now looks approximately like it did
originally, but not exactly.

Updating the full polygon selection

12.On the Tools rollout, in the Hairdo group, click
Paste.

Pasting the original hairdo to complete the toupee

You now have a hair toupee that you can
plant under the skin of your characters.
For best results, make the surface polygons
non-renderable (Edit > Object Properties >
General Panel > Rendering Control group >
Turn off Renderable).

Using “toupees,” you can create a library of
custom hair setups, retaining only the essential

geometry: that is, only those polygons from
which the hair grows.

Method 2: The Wig

For the “wig” method, you first convert the hairs
to an editable spline object, then use the spline
object to grow new hair.

1. Open the file wig_start.max.

2. Select the head object (objpCube1) and go to
the Modify panel.

3. On the General Parameters rollout, reduce the
Hair Count to 2200.

The initial value of 22,000 is a huge processing
load.

4. On the Tools rollout, in the Convert group,
click Hair -> Splines.

Hairs converted to splines

5. Press Delete to delete the original mesh
object.
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Hair splines after deleting the mesh

6. Select the resulting spline object and then apply
a Hair And Fur modifier.

This creates a spline growth.

New hair grown from the splines

Because it’s a spline growth, not a mesh growth,
the interpolation is uneven. To resolve this,
you’ll disable interpolation.

7. On the General Parameters rollout, turn off
Interpolate.

This means that Hair won’t fill in between the
guides. In other words, you’ll have one hair per
spline, if the Hair Count is set high enough.

8. Turn off displacements by setting values Rand.
Scale, Frizz Root and Tip, and Kink Root and
Tip to 0.0.

The original values are already reflected in the
spline object you created.

With Interpolation and displacements turned off, the
new hair follows the splines.

9. On the Multi Strand Parameters rollout, set
count to 20, and also set Root Splay and Tip
Splay to 0.5.

10.Render the Perspective view.

The rendered wig

You now have a hair description that is
independent of any mesh, upon which you can
run dynamics if you like.
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Method 3: The Transplant

The “transplant” method essentially consists of
copying the hairdo, selecting a target surface that’s
positioned as closely as possible to the original,
adding a Hair And Fur modifier to the new surface,
and then pasting the hairdo.

The steps that follow also show what goes on inside
Hair when you copy and paste hairdos.

1. Open the file transplant_start.max.

2. On the Tools rollout, click Convert >
Guides->Splines.

Hair guides (not all hairs) converted to splines

This differs from the wig method (described
above) in that this time, we use the hair guides
instead of the individual hairs.

3. Save the hair settings by clicking Tools
rollout > Presets > Save. Name the preset
temp_hair_material.

4. The head is no longer necessary, so delete it.

Hair-guide splines with the mesh deleted

5. Position the spline object created in step 1
around a new growth mesh. This illustration
uses a Capsule primitive, but feel free to use any
type of object you like.
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Hair-guide splines positioned on a new surface

6. Apply a Hair And Fur modifier to the new
surface, select the polygons from which the hair
should grow, and then click Update Selection.

Hair regrown from a new polygon selection

7. Recover the original hair settings. On the Tools
rollout, in the Presets group, click Load. and
then in the presets dialog, double-click the
temp_hair_material thumbnail.

8. On the Tools rollout, click Recomb From
Splines, then in a viewport, click the spline
object that was converted from the hair guides.
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The recombed hair

Note: Technically, you don’t need the spline
object after this step, but you might want to
keep it around for a future hairdo.

9. Render the Perspective view.

The rendered transplant

Cloth

Cloth Tutorials

Laura by Georges Walser

The tutorials included in this section walk you
through a variety of methods for using Cloth.

Features Covered in This Tutorial

• Using the Garment Maker

• Applying the Cloth modifier

• Locking points on the cloth

• Adding space warps and collision objects to the
cloth

• Running a Cloth simulation

• Adjusting fabric properties

Tutorial Files

All the files necessary for this tutorial are provided
on the program disc in the \tutorials\cloth
directory. Before starting the tutorials, copy
the \tutorials folder from the disc to your local
program installation.

In This Tutorial

For best results, follow the tutorials in this order:
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Creating a Billowing Flag (page 761)

Designing a Shirt (page 765) (in three parts)

Tailoring and Fine-Tuning (page 780)

Using Cloth with Bipeds (page 783)

Creating Pleats (page 784)

Creating a Billowing Flag

This quick-start tutorial will introduce you to
some of the basic concepts you’ll need when using
Cloth. It is meant simply to provide an overview
to the Cloth modifier. Do not be concerned if you
don’t understand the entire process, as the "why"
will be explained further in the later tutorials.

Create a cloth flag from a spline object:

1. Load quickstart.max from your \tutorials\cloth
folder.

This scene contains a rectangular spline object
named Flag and a cylinder named FlagPole.

2. Select the rectangle shape named Flag and
apply the Garment Maker modifier to it.

Modifier stack with Garment Maker modifier applied to
the Editable Spline object Flag
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The resulting Flag object is now a 3D mesh.

This turns the 2D spline into a 3D mesh that
you can use as cloth.

The corners of the new mesh get "rounded"
because the flag spline was not set up correctly.

3. Delete the Garment Maker modifier.

The spline object reverts to its original status.

4. Access the Vertex sub-object level and then
select all four vertices of the spline (press
Ctrl+A ).

5. On the Geometry rollout, click Break.

Flag with vertices broken

This causes the segments within the spline
to become independent, as shown above.
This preserves the corners when you apply
Garment Maker. Whenever you have a spline
that changes appearance after the application of
Garment Maker, check the vertices and break
the ones that cause this kind of issue.

6. Exit the sub-object level and then reapply the
Garment Maker modifier.

Flag with Garment Maker applied

Apply and set up the Cloth modifier:

1. With the Flag object still selected, apply the
Cloth modifier to it.

2. On the Object rollout, click the Object
Properties button.

This opens the Object Properties dialog.
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First, you’ll tell Cloth which objects should be
part of the cloth simulation. Currently only
Flag is present in the left-hand column of the
Object Properties dialog; the FlagPole object
should be part of the simulation as well.

3. On the Object Properties dialog click the Add
Objects button, select FlagPole, and then click
OK.

This adds the FlagPole object to the simulation.

Next you’ll set which Objects are to act as cloth
and which objects the cloth will interact or
collide with.

4. In the list on the left side of the Object
Properties dialog, click Flag, and then click the
Cloth radio button.

This tells the simulation that Flag is to be a cloth
object.

5. In the list on the left side of the Object
Properties dialog, click FlagPole, and then click
the Collision Object radio button.

This tells the simulation that FlagPole is a
collision object with which the cloth object can
interact.

6. Click OK to close the Object Properties dialog.

Run the simulation:

Before you simulate, it’s a good idea to check the
cloth scale to make sure you get the results you
might expect. To do this, you’ll measure the flag
as it relates to the cloth simulation. Cloth works
in real-world units to create its simulation, so it’s
important to make it a habit to check the size of
your objects.

1. Go to the Create panel and click the Helpers
button.

2. Click Tape, and then in the Front viewport drag
out a Tape helper to determine the width of the
flag.

You’ll find that it is approximately 165 3ds Max
units in width. Currently, Cloth is set (in
the Simulations Parameters rollout) to 2.54
cm/unit, which equals 1 inch per unit (2.54
cm=1 inch). So at 165 inches wide, the flag
is 13.75 feet wide, which is a big flag. That’s
not unrealistically large, but it is big, which is
something to keep in mind because it affects
the cloth behavior.

3. On the Cloth Object rollout, click Simulate. Let
the simulation calculate for a few frames. After
about 35 frames, press the Esc key to stop the
simulation.

The flag falls to the ground because it is not
attached to the flagpole in any way. To attach
the flag to the flagpole, you will need to access
the Cloth Group sub-object level and create a
group of vertices to attach to the flagpole.
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Attach the flag to the pole:

1. Go to the Group sub-object level of the Cloth
modifier.

The flag vertices become visible.

2. In the Front viewport, select the column of
vertices on the Flag object nearest the flagpole,
as shown below.

Vertex selection for FlagPole binding

3. On the Group rollout click the Make
Group button, and then name the group
FlagPoleSelection. Click OK to close the
dialog.

Now that you’ve made and named a group, you
need to assign it to the flagpole.

4. On the Group rollout click the SimNode button,
and then pick FlagPole by either selecting it in
the viewport or by pressing the H key and
using the Select Objects dialog.

Alternatively you could attach the flag to the
flagpole using the Surface constraint, but that
method locks each vertex to the triangle on the
chosen object whose center is closest to the
vertex. In the case of the flagpole, some of the
vertices would be pulled toward the cylinder
cap triangles to which they are closest, which
might create unexpected results.

5. Exit the Group sub-object level.

Run and refine the simulation:

1. On the Object rollout click Simulate.

The flag drapes down and is held up by the
flagpole, but it doesn’t seem to drape very
naturally. This is due to the size of the cloth.
Remember that you determined that the flag is
almost 14 feet wide, so you now need to edit the
cloth properties for the flag so that it behaves
more realistically.

2. Click the Object Properties button, and then
in the left-hand column of the floating dialog
click Flag.

3. Change the Shear value to 350.0.

4. Change the U Bend value to 50.0.

Altering these two parameters forces the cloth
to be less flexible, cause more realistic folds in
the cloth drapes.

5. Close the Object Properties dialog, and then
click Erase Simulation to remove the existing
simulation data.

6. Click Simulate again to see the flag drape.

Add a wind force:

To make the simulation more realistic, you’ll use
a Wind space warp to make the flag flap in the
breeze.

1. Go to Create panel > Space Warps > Forces
and then add a Wind space warp In the Left
viewport.

2. Rotate the space warp to point in the same
direction as the flag, as shown below.
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Wind space warp placement in the scene

3. With the Wind space warp selected, go to the
Modify panel and change the Strength value
to 10.0.

Next you’ll tell the Cloth simulation to take the
wind into account by adding it as a force.

4. Select the Flag object and then on the Object
rollout click the Cloth Forces button.

This opens the Forces dialog.

5. In the Forces In Scene column, click Wind01
and then click the right-arrow button in
the center to move it over to the Forces in
Simulation column. Click OK to exit the dialog.

6. Erase the simulation again and then click
Simulate and let the new simulation run to
completion.

Flag blowing after simulation is complete

You can see how easy it is to create a simple
cloth object with Cloth. Now that you’ve had
a taste of how the system works, you’ll use the
major Cloth features to build a realistic shirt
for a character model.

Next

Designing a Shirt (page 765)

Designing a Shirt

In this tutorial, you will go through the process of
building a shirt for a character from scratch.

The first lesson will lead you through several key
features of the Garment Maker modifier that let
you design the patterns that will be used to create
the garments.

The concepts covered in this lesson are as follows:

• Drawing splines for the pattern

• Applying Garment Maker to the pattern

• Working with MultiSegment splines

• Positioning the Garment Maker panels over the
character

• Creating seams

Create the shirt pattern:

1. Load tutorial_1.max from your \tutorials\cloth
folder.
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This scene contains a character for which you
will make a shirt.

2. Select the character named Jester. In the Front
viewport, rotate it -90 degrees on the X axis.

The Jester character model should now be
facing upward in the Top viewport. Garment
Maker requires that you create patterns in
the Top viewport. Rotating the character will
allow you to use it temporarily for fitting while
creating the pattern. When you’ve finished
creating the patterns, you will rotate it back.

Next you’ll start to make a pattern for a shirt.
First you’ll create the panels that will make up
the front and back of the shirt.

3. On the Create panel click Shapes > Line,
and create a spline in the Top viewport that
resembles the front of a shirt without sleeves.
This will look something like a vest, as shown
below.

Front of shirt in the Top viewport

Next you’ll make the sleeve for the shirt. The
sleeve is basically one long piece of fabric that
wraps around the arm, with a seam at the
bottom. The end of the sleeve that will attach
to the shirt should be curved to better fit the
shoulder area.

4. In the Top viewport, create a spline sleeve that
fits the arm’s length, and is about three to four
times the arm’s width.

Sleeve in the Top viewport

5. Copy the sleeve and front panel splines of the
shirt so that you have a front and back plus two
sleeves. Also, rotate the sleeve on the left so that
it is properly oriented, as shown below.

Pattern panels copied and arranged

Next you’ll combine all the pieces and set them
up to be sewn together.

6. Use the Attach function to combine all the
editable splines into one object and name it
Pattern.

In order for Garment Maker to work, all of the
panels that are created as part of a single piece
of clothing must be part of the same object.
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That’s why you attached all the splines. Next
you’ll break off different segments of the pattern
so that these edges can be sewn together.

7. At the Vertex sub-object level, select all four
corner vertices of both sleeves and then click
Break.

Vertices selected for breaking

This will give you four separate splines to select
and sew together instead of having only one
spline. When you work with Garment Maker,
you need to make sure that your shape contains
separated splines to use as the seam edges.

8. Select the eight corner vertices on both the
front and back pieces of the shirt, and click
Break again.

Vertices selected for breaking

Now that the pattern is ready, you’ll apply the
Garment Maker modifier to make this 2D
spline pattern into a 3D mesh.

9. With the Pattern spline selected, go to the
Modify panel and apply the Garment Maker
modifier.

When you apply Garment Maker to the
closed splines it fills them in with an irregular
triangular mesh that is designed for cloth
deformation.

Fit the shirt to the character model:

Now that you’re done with the preliminary
creation and sizing for the pattern, you’ll rotate the
Jester back into standing position.

1. In the Front viewport select the Jester object
and rotate it 90 degrees around the X axis.

The next step is to position the panels of the
pattern around the character.

2. Go to the Panels sub-object level of the Garment
Maker modifier and select the panel that makes
up the front of the shirt.

3. Move the panel into place in all four viewports
so it lines up well with the front of the character.
This panel will need to be rotated 90 degrees
around X and moved up and forward a bit to
line up with the character as shown below.

Positioning of the front shirt panel

4. Still at the Panels sub-object level, select the
panel that makes up the back of the shirt. Move
and rotate this panel into place. This panel will
need to be rotated 90 degrees around X as well
as 180 degrees around the Z axis so the mesh
is facing outward.

5. Move the sleeve panels into place above the
arms.
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Positioning of the back and arm shirt panels

You’ll adjust a few parameters of the panels
before adding the seams to the shirt’s panels.

6. At the Panels sub-object level select one of
the sleeve panels. In the Panels rollout’s
Deformation group choose the Curved radio
button option. Set the Curvature value to -3.0
and choose the Y-axis option.

This causes the sleeve panel to bend around the
arm.

7. Using the Move and Rotate tools, reposition the
panel to fit more closely around the arm.

If the sleeves are not wide enough to curve
around the arm, go back to the Editable Spline
level on the stack to make them a bit wider. To
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get Garment Maker to recognize this change,
tweak the Density spinner up and down in the
Garment Maker > Object rollout after editing
the splines.

8. Repeat these steps to curve the other sleeve
and position it to resemble the following
illustration.

Sleeve panels with curvature

Make the shirt seams:

All the panels are in place, so next you’ll make
some seams for sewing them together. You
can make seams at both the Curves and Seams
sub-object levels. The Curves level is a good place
to make seams quickly if you know exactly how
they need to connect. However, this method can
be a bit confusing at first. Therefore, you’ll use the
Seams level because it gives more visual feedback.

1. Go to the Seams sub-object level of the Garment
Maker modifier. Select the edge on the front
panel of the shirt above the left shoulder. It
turns red to indicate it is selected.

2. Press and hold the Ctrl key, and then select
the corresponding edge on the back panel of the
shirt. On the Seams rollout click Create Seam.

If a dialog box comes up that reads, “Seamed
segments not within tolerance,” increase the
value for the Seam tolerance on the Seams
rollout. You might also get a twisted seam. If
this happens, click Reverse Seam on the Seams
rollout.

Left: Twisted seam

Right: Correctly aligned seam

Most of the seams for clothing can be made as
easily as this: Select two edges and then click
Make Seam.

The exception to this is creating the seam
between the sleeves and the arm holes. There
are three seams involved here instead of two:
the front half of the arm hole, the back half of
the arm hole, and the sleeve edge itself. You
must first make the arm holes on the front and
the back of the shirt into one segment. You will
do this by making a "MultiSegment" seam.

3. Select both segments for the arm hole on the
front and the back of the shirt. It is important
that you select the segments on the same side of
the body on which you just made a shoulder
seam. When both edges are selected, click
Make MultiSegment on the Seams rollout.
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Segments selected for making MultiSegment

Now, if you deselect and select either the
back or front segment, both will be selected
or deselected because Garment Maker now
considers them to be one segment.

4. Select the MultiSegment you just made, and
then select the sleeve edge. Click Create Seam
to attach the sleeve.

Seam attaching sleeve to body

5. Create the seams for the rest of the segments on
that side of the body. Don’t forget the underside
of the sleeve.

Seams for left side of body

6. Use the same method to create the seams for
the other side of the body.

Remember to create the shoulder seam first and
then make the MultiSegment seam. When dealing
with MultiSegment seams, the order of creation is
important. If you attempt to create seams in the
wrong order, you might get a “Seamline topology
is wrong” error, and the seams will not be created.
When dealing with MultiSegment seams, create
the minimum number of seams necessary to make
the MultiSegment seam match the topology of the
other piece to that you are going to connect. In
this case, you have an arm seam that is open at
the bottom, and a MultiSegment that is open at
both the top and the bottom. By closing the top
of this MultiSegment with a seam at the shoulder,
you’ve created proper topology to make the
MultiSegment seam.

To recap this first lesson, you created a pattern for
a shirt from standard splines, applied Garment
Maker, positioned them over the character and
then created the seams that will be used to sew the
panels together. In the next tutorial, you will see
how to make the flat panels look more like a shirt.
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Designing a Shirt, Part 2

In this next tutorial, you’ll take the patterns you
built in the first tutorial, and you’ll apply Cloth to
begin the process of turning the panels into a shirt.

This lesson covers the following concepts:

• Assigning cloth and collision objects

• Bringing the seams together

• Assigning clothing properties

• Running the local simulation to fit a garment

1. Open tutorial_2.max from your \tutorials\cloth
folder.

This scene contains the Jester character and
the shirt pattern with seams in place from the
previous lesson. Now that all the seams are in
place on the pattern, you will add the Cloth
modifier to form the pieces into the shirt. The
first task is to decide on the scale of the scene.

If you use the Measure utility, you can see
that the Jester character is about 77 3ds Max
units tall. If we set one unit to one inch, what
would make him 77 inches (6 feet, 5 inches)
tall, including the hat, which seems reasonable.
Since we want to use 1 3ds Max unit=1 inch,
that means 1 unit=2.54cm, so the cm/unit
setting in Cloth will be set to 2.54; this is the
default.

2. Select the Shirt object, go to the Modify panel,
and apply the Cloth modifier to it.

Since we want cm/unit=2.54, there is no need to
change this value, but please keep in mind that
it is very important to set this value correctly
before attempting a simulation.

The Object Properties button on the Object
rollout opens the Object Properties dialog,
where you add objects to the simulation and
assign them different properties.

3. Click the Object Properties button. In the left
column of the Object Properties dialog, click

the Shirt entry and then choose the Cloth radio
button on the right.

This sets the shirt to be a cloth object in the
simulation.

Take note of all the Cloth Properties parameters
that can be adjusted when an object is set to be
cloth. You can use these parameters to get the
fabric type you want, or you can use a preset.

4. With the Shirt still highlighted in the left
column, choose Cotton from the Presets
drop-down list.

This sets all of Cloth Properties to simulate
cotton.

If you were to simulate now, the shirt would
simply fall to the floor because it’s the only
object in the simulation currently. You’ll add an
object for the cloth to collide and interact with.

5. On the Object Properties dialog, click the Add
Objects button.

This opens a list of objects in the scene.

6. Click the Jester and then click OK.
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When you add objects to the simulation, it is
the same thing as instancing the Cloth modifier
to those objects. Each object that is part of the
Cloth simulation will have a Cloth modifier
assigned to it. Be aware of this as you set up
your own simulations.

7. With Jester still highlighted in the left column,
click the Collision Object radio button on the
right near the bottom.

8. Set the Offset parameter to 0.25, which will
keep the cloth a quarter of a 3ds Max unit away
from the body (the default of 1.0 is a little large
for this scene).

9. Click OK to close the Object Properties dialog
and set the parameters.

At this point, you have set the shirt to react like
cloth, and the Jester’s body to collide with it.
You are now ready to convert the panels into a
shirt. You do this with a local simulation.

Before you simulate sewing the garment
together, you’ll turn gravity off.

10.Scroll down to the Simulation Parameters
rollout, and click the Gravity button so it is no
longer highlighted and active.

11.In the Perspective viewport, zoom in a bit to
get a closer look at the shirt, then still within
the Cloth modifier, go to the Object rollout,
and click then Simulate Local. When the seams
have pulled the shirt mostly together, press the
Esc key to stop the simulation.

As you can see in the image above, the panels
have pulled together and are draped over the
Jester character. However, the seams have not
come together to form a single garment and the
green sewing springs are still visible. In order
to get the seams to snap together completely,
you will need to perform one more operation.

12.On the Simulation Parameters rollout, turn off
Use Sewing Springs.

The green lines disappear.

13.Turn Gravity back on, and then back on the
Object rollout, click Simulate Local again.
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14.Let the simulation run until you are satisfied
with the fit, and then press the Esc key to stop
it.

Now the shirt is complete. Next, you can
animate the character and simulate the cloth
over the animation. But before you animate
your character, you’re going to give the shirt a
pocket to add some detail to it.

Add a pocket:

Now that the shirt is coming together, you’ll add a
pocket to it in order to give it some more detail.
This tutorial will introduce you to the idea of
attaching one cloth object to another as well.

The following concepts are covered in this lesson:

• Garment Maker creation

• Creating and using groups

• Assigning separate cloth properties

1. Load tutorial_3.max from your \tutorials\cloth
folder.

This scene contains the Jester character and
the shirt simulated from the previous lesson.
If the scene opens with the panels apart and
the garment looking stretched out, there’s an
easy fix. Occasionally you will see a scene file
with the panels not together and the triangles
distorted. To fix this, just turn on Use Sewing
Springs, click Reset State, and then use Simulate
Local to rebuild the shirt as it was at the end of
the previous tutorial.

Now that the shirt is in place, you will add a
pocket to it to make it look like a fancy T-shirt.

You’ll start by creating a pocket to add in the
same way you made the shirt pattern.

2. In the Top viewport, zoom into the front of the
Jester’s body, then draw out a pocket shape
with the line tool using Create panel > Shapes >
Line. Make the pocket an appropriate size for
the shirt and name the object Pocket. Be sure

to go to the Vertex sub-object level and break
all the vertices.

Spline pocket in the Top viewport

3. With the Pocket object selected, apply the
Garment Maker modifier to it.

4. Go to Panels sub-object level of the Garment
Maker modifier, and then move the pocket into
place just in front of the shirt. You might want
to rotate the pocket a bit to more closely align it
with the chest portion of the shirt. When you’re
done, exit the sub-object level.

Pocket positioned at the Panels sub-object level
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Now that the pocket is in place, you will need to
add it to the simulation.

5. Select the shirt, and then click Object
Properties. On the Object Properties dialog,
click Add Objects to open a list of objects in the
scene. Click Pocket and then click OK. With
Pocket still selected in the left column, click the
Cloth radio button on the right. Click OK to
close the Object Properties dialog.

Before attaching the pocket to the shirt, it’s
advisable to make the mesh densities of the two
objects similar. Right now, the mesh density of
the pocket is higher than the shirt, which can
cause crumpling at simulation time.

6. Select the Pocket object, and then access the
Garment Maker modifier in the stack. On the
Object rollout, change the Density value so
the mesh density of the pocket more closely
matches that of the shirt. A value of 3.0 should
work.

Next you’ll attach the pocket to the shirt. You
can do this at the Group sub-object level of the
Cloth modifier.

7. Select the Pocket object, and then go to the
Group sub-object level of its Cloth modifier.
This level lets you select vertices. Select the
vertices at all edges of the pocket except the top
edge, as shown below.

Pocket vertex selection

8. Click the Make Group button and name the
group PocketEdge.

You’ll see a new group in the Group rollout list
named “PocketEdge (unassigned).”

9. With this group still selected, click the Cloth
button and pick the shirt by selecting it in
the viewport or by pressing the H key and
selecting it by name.

Now the Group should be named “PocketEdge
(cloth to Shirt).” This lets you know that you
have attached the group of vertices to the shirt
object as a piece of cloth.

10.Return to the base level of the Cloth modifier,
so you are no longer in Group sub-object
mode. Make sure Gravity is not active on the
Simulation Parameters rollout.

11.Click Simulate Local to conform the pocket to
the shirt.

12.This should take only a few frames, and you
should also realize that this process will also
further refine the shirt’s fit itself, so don’t let the
simulation run too long.
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Pocket conformed to the shirt

As you have seen, adding extra detail to a piece of
clothing is not a very difficult process. Attaching
one cloth object to another is simply a matter of
creating a group of vertices and choosing the other
cloth object to attach it to. In the next lesson you
will expand on this knowledge to create a collar
and cuffs for the shirt, as well as assign different
material properties to them.

Next

Designing a Shirt, Part 3 (page 775)

Designing a Shirt, Part 3
Add a collar:

Now that you’ve had a taste of adding detail to
a garment, it’s time to look at some of the more
advanced attributes within Cloth. In this tutorial,
you’ll add a collar and cuffs to a simple shirt
design, and change their seams to create creases
within the garment.

The concepts that will be covered in this lesson are
as follows:

• Creating seams and positioning Garment
Maker panels

• Using the Seam Strength and Seam Angle
controls

• Simulating multiple times to get a garment into
position

1. Load tutorial_4.max from your \tutorials\cloth
folder.

This scene contains a character and the shirt
from the previous lesson. This shirt has some
additions to it as shown in the following
illustration. Two extra pieces have been added
for the collar, and one extra piece per arm for a
cuff. The cuff is a bit narrower than the sleeve.

Shirt layout with collar and cuffs added to the basic
pattern

2. Select the shirt, and on the Modify panel, turn
on the Garment Maker modifier so the panels
move into place.

The shirt is set up as in the previous lesson with
most of the seams created for the arms, back
and front of the shirt. You’ll adjust the curve of
the cuffs and collar and apply seams to them.

3. Go to Panels sub-object level of Garment
Maker, and select one of the cuffs. In the
Deformation group on the Panels rollout,
choose Curved, and set the curve to -5.0
around the Y-axis.

Now that the cuff is curved around the arm,
you can add its seams.

4. Go to the Seams sub-object level of Garment
Maker and create a seam between the sleeve
and the cuff. Then create the seams for under
the sleeve and under the cuff. Create your
seams in this order or you might get topology
dependency errors.
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Seams for the underarm and cuff

Now that you have made the seams for the cuff,
you will edit the seam attaching it to the sleeve
to get a cuff-like result. Where the cuff meets
the sleeve, there should be a clear crease and a
bunching of the sleeve.

5. At the Seams sub-object level, select the seam
(the green sewing springs) that joins the cuff
and the sleeve. On the Seams rollout, set Crease
Angle to 90.0 and Crease Strength to 100.0.

This will make the seam try to maintain an
angle of 90 degrees.

6. Complete steps 3-5 for the other side of the
body.

Now you’ll take a look at the collar. It would
probably be best to make the seams for
the collar first, and then change the curve
afterward.

7. At the Seams sub-object level, create a seam
between the back of the shirt and the bottom of
the closest collar piece.

Seam from the back of the shirt to the bottom of the
collar

8. Next, create a seam between the tops of the two
collar pieces. If necessary, click the Reverse
Seam button to straighten out the seam.

Next you’ll bend the collar panels and move
them into place.

9. At the Panels sub-object level select the base of
the collar and apply a curvature of -3.0 around
the X-axis. Select the other piece of the collar
and apply a curvature of -2.0 around the X-axis.

10.Select each of the collar places and move them
into place around the neck and above the
shoulders, as shown below.

Collar bent and positioned

Next you’ll edit the seam of the collar as you did
the cuffs. This will let the folded part of the
collar stand out a bit.

11.Select the seam between the top of the two collar
pieces in Seams sub-object mode. Set Crease
Angle to -75.0 and Crease Strength to 25.0.

Now you are ready to add the Cloth modifier
and simulate.

12.Apply the Cloth modifier to the shirt.

13.On the Object Properties dialog, set the shirt to
be cloth, and choose the Cotton preset from
the drop-down list.
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14.Add the Jester to the simulation, and make
the Jester a collision object. Close the Object
Properties dialog by clicking OK.

15.Turn off Gravity, and then Simulate Local with
Use Sewing Springs on to bring the panels
together.

16.Stop the simulation and then, on the Simulation
Parameters rollout, turn off Use Sewing
Springs.

Turning off Use Sewing Springs tells Cloth to
compute the seam angles and strength for the
cuffs and collar.

17.Turn Gravity back on, and then Simulate Local
again with Use Sewing Springs off to further
refine the garment’s position and fit.

If you don’t get the right result the first time,
you might want to turn Use Sewing Springs
back on and Reset State. This will allow you to
perform the local simulation again.

Simulated shirt with collar and cuffs

This lesson has provided you with additional
ways to control how your fabric behaves and is
joined together. In the next lesson you’ll look
at how you can further refine the look and
behavior of your clothing by assigning different
cloth properties to the panels of garments.

Apply various cloth settings to different parts of the
shirt:

In the last lesson you looked at different controls
that help define how your fabric behaves. In
this lesson you’ll apply different cloth settings
to various parts of the shirt to create a more
convincing look.

The concepts that will be covered in this tutorial
are as follows:

• Assigning separate Cloth properties for panels

• Assigning different materials for panels

• Assigning separate Cloth properties with a
material

1. Load tutorial_5.max from your \tutorials\cloth
folder.

This scene contains a character and the
shirt from the previous lesson. You’ll add
some different properties to the cloth panels
themselves.

2. Select the shirt and then, on the Cloth modifier
Object rollout, click Object Properties to open
the Object Properties dialog. Highlight the
Shirt entry in the left column and then turn
on Use Panel Properties. Click OK to exit the
dialog.

This will let you set the cloth properties for the
entire shirt on a panel-by-panel basis.

3. Go to the Panel sub-object level of Cloth and
select one of the cuffs. It will turn red it indicate
that it’s selected.

You can change all of the parameters for how
the fabric reacts here on the Panel rollout.

4. From the Presets drop-down list, choose
Generic Heavy.

This sets the cuff to deform like a heavy or stiff
piece of fabric.

5. Select the different panels of the collar and the
other cuff and set them to the Generic Heavy
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preset. Be sure to choose the preset even if it is
already displayed in the list.

6. Select each of the other shirt panels, and set the
preset to Cotton.

This will make most of the shirt behave like
cotton except for the collar and cuffs, which
will be heavier and less flexible, as if they were
starched.

Now it’s time to rerun the simulation.

7. Exit the Panel sub-object level and go to the
Object rollout of the Cloth modifier. Be sure
Use Sewing Springs is on in the Simulation
Parameters rollout, and then click Reset State
from the Selected Object Manip group of the
Object rollout.

This resets the state of the shirt so you can run
the local simulation again.

8. Run the local simulation again, first with Use
Sewing Springs on for a bit, and then run
the local simulation with Use Sewing Springs
turned off. You might also use Simulate Local
(damped), which adds a heavy damping to the
fabric as it simulates.

9. If you are not satisfied with the results, click
Erase Simulation and then rerun the simulation
until you like the positioning and drape of the
shirt.

Now that you have different fabric properties
for the cuffs and the collar, you’ll set up some
different materials and densities. If you take a
look at the end of the cuff, you will see it seems
a bit low-poly and chunky.

Slightly chunky-looking cuff

10.If necessary, select the shirt, and then go down
the modifier stack to the Garment Maker
modifier.

You’re going to change the density of different
parts of the shirt next. In order to do this so
you don’t have to re-simulate the garment
afterwards, you’ll first check to make sure that
you preserve the shirt’s position.

11.In the Garment Maker modifier, make sure the
Preserved Surface radio button is chosen.

12.Go to the Panels sub-object level and select
one of the cuffs. On the Panels rollout, change
Density to 3.0 and set the Mat ID to 2. Do this
for the other cuff as well.

This will let you apply a different material to
the cuffs only.

13.Select each panel of the collar and change its
Density to 2.0 and its Mat ID to 2.

14.Use the Material Editor to create a
Multi/Sub-Object material with two
sub-material slots. Change the two
sub-materials to any colors you like, apply the
material to the shirt, and then render.
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Smooth cuffs with separate materials applied

You changed the cloth properties via the Panel
sub-object level; you’ll now learn about an
alternative method that can add some flexibility
to assigning cloth properties. You’ll use a
grayscale map to determine which parts of the
shirt are made of which types of fabric.

15.Go back up the stack to the Cloth modifier, and
open the Object Properties dialog by clicking
Object Properties on the Object rollout.

16.Highlight the Shirt entry on the left, and then
turn off Use Panel Properties.

17.Choose the Cotton preset.

Now the entire shirt is set back to cotton.

18.In the upper-right corner of the Object
Properties dialog, click the Property 2 radio
button. Choose the Cotton Generic Heavy
preset.

19.Click OK to exit the dialog.

Now you have two different sets of cloth
properties you can modify and assign to the
shirt.

20.Open the Cloth modifier’s Material Params
rollout.

Note: This rollout is available only when a single
object is selected.

The Interpolate option is currently active. This
option lets you move the slider to interpolate
between the two properties you just set for the
cloth, and even animate between them if you
wish. But for now you’ll use the other option:
Texture Map. This lets you to use a grayscale
texture map to assign fabric properties. White
pixels will assign Property 1, black pixels will
assign Property 2, and values in between will
blend between the two sets of properties.

21.Open the Material Editor and create a new
material. As the Diffuse map type choose
Bitmap and choose the shirtprop.bmp from
your \maps folder.

22.Apply this material to the shirt.

23.Reset the initial state, making sure Use Sewing
Springs is on. Go to the Object rollout of the
Garment Maker modifier and choose the Flat
Panels option.

This lays out the panels in a manner that is
appropriate for UVW mapping.

24.Above the Garment Maker modifier apply a
UVW Map modifier. Keep the Planar default
mapping type and adjust the size to fit properly.
Make sure Show End Result toggle is off below
the modifier stack display so you can see the
panels.

UVW modifier in the Top viewport
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Modify panel with UVW Mapping modifier

25.Go back up to the Cloth modifier in the stack.

26.On the Material Params rollout, choose the
Texture Map option and then click the None
button to get the texture. On the Material Map
Browser dialog choose Browse From > Mtl
Editor, and then choose the Diffuse map you
just added to your shirt.

You’re now ready to simulate again.

27.Use Simulate Local as before to conform the
shirt to the character with the new settings.

Now the fabric parameters are defined by the
black-and-white map to make the cuffs and
collar a bit stiffer than the rest of the shirt. You
can now apply any material you want to the
shirt.

Simulation with cuffs and collar properties set by
material

As you can see, giving a single piece of clothing
multiple cloth properties is not difficult, and
can generate results that would be impossible
otherwise. Now that you can construct
garments and give them properties to make
them behave as you would like, you’ll start
looking into how you can refine the design of
the clothes you build so they fit the characters
better.

Tailoring and Fine-Tuning

As you begin to create more complex clothing,
you’re most likely going to want to create the
garments for your characters, then be able to go
back and refine them to make them fit better. In
essence, you’ll be acting like a virtual tailor. This
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tutorial introduces you to the traditional sewing
concept of darts, and how they can help you build
better clothing.

The concepts that will be covered in this tutorial
are as follows:

• Using darts with Garment Maker

• Creating seams for darts

• Modifying darts after simulation to get a better
fit

Fit a dress with darts:

1. Load tutorial_6.max from \tutorials\cloth
folder.

This scene contains a character model and a
pattern for a sun dress. This sun dress has darts
in it to help it fit the character’s body closely
while still being a very simple pattern.

2. Select the SunDress object.

The darts in the pattern appear as thin
diamonds.

3. Go to the Modify panel and turn on the
Garment Maker modifier.

Most of the seams for the dress are already
made. The ones you’ll focus on are the darts.

Darts marked in red

4. Go to the Seams sub-object level of Garment
Maker. Select the two seams of one of the darts
and then click Create Seam.

Seam made for one dart (far right) and selected edges to
create a seam for the next dart

5. Proceed around the dress making seams for
each dart.

6. Apply the Cloth modifier to the dress.
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7. On the Object rollout click Object Properties.
Highlight the SunDress entry in the list on the
left, click the Cloth radio button, and then
choose the Cotton preset from the drop-down
list.

8. Click the Add Object button and then add the
Girl to the simulation. With the Girl entry
highlighted click the Collision Object option.
Click OK to exit the dialog.

9. On the Object rollout choose Simulate Local
(damped). Once your dress is partially formed
to the figure, stop the simulation, turn off Use
Sewing Springs in the Simulation rollout, and
then simulate locally again for a bit.

The shoulder straps are floating too high above
the shoulders, so you’ll decrease the offset a bit.

10.Open the Object Properties dialog again and
choose the Girl entry in the list at the left. In the
Collision Properties group reduce the Offset
value to 0.6. Click OK to close the dialog.

11.Click Simulate Local (damped) to tighten up
the dress.

The resulting dress has some bunching on
both sides under the chest. This bunching is
what the darts are designed to minimize or
eliminate. You should be able to get a better fit
by repositioning the darts and making them
a little larger.

Bunching on both sides of the dress

12.Go to the spline level at the bottom of the
modifier stack and then access the Vertex
sub-object level. In the Top viewport,
reposition the outside darts to be larger, and
position them more toward the top of the dress
as shown below.

Darts moved up and widened

13.Garment Maker doesn’t register changes in the
spline shape until the mesh is regenerated, so
now you need to click the Mesh It And Preserve
button, which lets you keep the dress in place
as it adjusts to the new dart positioning. If you



Using Cloth with Bipeds 783

clicked the Mesh It! button instead, the dress
would revert to the pre-sewn configuration.

14.Go up to the Cloth modifier, turn on Simulation
Rollout > Use Sewing Springs, and then click
Reset State.

15.Run the simulation locally again until you’re
satisfied.

You should get a much better fitting dress.

Results after manipulating the darts

Using Cloth with Bipeds

Cloth is a complex system, so it makes sense to
learn how it functions in concert with another
character animation tool, namely the Biped
functionality in 3ds max.

The following concepts are covered in this tutorial:

• How to slow down the character’s initial pose
so the initial Cloth simulation can occur. The
idea here is that motion-capture data imported
into both products will position a character at
frame 0, which can cause problems for Cloth
because it wants to simulate over at least 30 to

90 frames before motion begins, generally in a
neutral pose.

• Truncating a simulation

• Capturing an initial state

Clothe an animated biped:

1. Load tutorial_7.max from your \tutorials\cloth
folder.

This scene has a biped standing in the “Da
Vinci” pose.

Biped in Da Vinci pose

2. Select all the biped parts and then go to the
Motion panel.

3. On the Copy/Paste rollout, click Copy Posture.

Now this posture is saved for you to get later.

4. On the Motion Capture rollout, click Load
Motion Capture File, and then load the file
backkick.bip from your \tutorials\cloth folder.
Click OK through the dialogs that follow,
accepting the default settings.

5. Open the Dope Sheet for Track View, and select
all of the Biped keys. Move the keys 30 frames
to the right.

This will give you 30 frames to transition
between the copied pose and the first
motion-capture frame.



784 Chapter 7: Hair and Cloth

6. At frame 0, on the Motion Panel > Copy/Paste
rollout, click Paste Posture.

7. On the Key Info rollout click Set Key.

Now when you scrub the time slider your
animation should transition smoothly between
the Da Vinci pose and the first frame of the
motion capture.

8. Unhide the Shirt object.

9. Select the Shirt object and then go to the
Modify panel and click Cloth modifier > Object
rollout > Simulation group > Simulate to get
the shirt to deform. At frame 30, press Esc
to halt the simulation.

10.At frame 30, click Cloth modifier > Object
rollout > Selected Object Manip group > Set
Initial State.

This sets the initial state of the shirt to be in
sync with the first frame of the motion capture.
Because Cloth requires some pre-roll for the
simulation, it provides you with the tools
needed to copy the cloth at any stage back to
frame 0.

11.Next, go to frame 0 and click Truncate
Simulation.

This removes the simulation after frame 0.

12.Choose File > New, and on the New Scene
options dialog, choose Keep Objects And
Hierarchy.

This removes all animation from the scene.

13.Import the motion capture file again. The cloth
will be in sync with it at frame 0, and you can
simulate the rest of the animation at that point.

This tutorial gave you a method for "staging"
your Cloth simulation.

Next

Creating Pleats (page 784)

Creating Pleats

In this final tutorial, you will learn more about
creating specific pleats within a garment to make it
look as if it’s just been ironed and pressed.

The concepts that will be covered in this tutorial
are as follows:

• Using a pattern with pleats in Garment Maker

• Creating seams for pleats

Sew the skirt sections together:

1. Load tutorial_8.max from your \tutorials\cloth
folder.

This scene contains a mannequin figure and a
pattern for a pleated skirt. This skirt has been
broken into several sections for a pleated look
when it gets sewn together.

2. Select the Skirt object.

Skirt pattern

This pattern object contains five sections that
will have pleats between them. You’ll connect
the five sections to the five segments on the
bottom of the waistband portion of the dress.

3. Apply the Garment Maker modifier to the Skirt
object.
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Garment Maker applied to the skirt panels

Next you’ll position and rotate the pattern into
place at the Panels sub-object level of Garment
Maker.

4. Go to Panels sub-object level and then position
and rotate the waistband portion of the pattern
near the character’s waist.

5. In the Panels rollout > Deformation group
choose Curved. Enter a Curvature value of -1.7
around the X-axis.

This bends the waistband portion of the skirt
around the character’s waist.

6. Move and rotate the skirt panels so they encircle
the character, as shown below. Take your time
and rotate the view around the character to get
a better sense of where the panels are in relation
to one another.

Panels rotated and placed around the character

Once the panels are in place you can make
seams to attach each panel to the waistband.

7. At the Seams sub-object level of Garment
Maker, select a segment on the bottom edge on
the waistband and the corresponding edge on
the top of a skirt panel.

Edges selected to make a seam

8. On the Seams rollout click Create Seam.

9. Attach the remaining panels to the waistband
with additional seams.
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Seams created attaching the waist band to the panels

10.Create a seam for the back of the waistband to
close it off.

Each adjacent pair of skirt panels need a seam
between them to keep them together and define
a pleat.

11.Select the edges of the two back panels to create
a seam between them and then click Create
Seam.

Seam created between back panels of the skirt

12.With this seam still selected, go to the Seams
rollout and change Crease Angle to 90.0 and
Crease Strength to 25.0.

Setting Crease Angle to 90 makes the seam try
to achieve a 90–degree angle during simulation.
The Crease Strength setting defines how hard
the seam will try to reach the set crease angle.
All of this happens during simulation when Use
Sewing Springs is off.

13.Repeat steps 11 and 12 with each pair of
adjacent panels in the skirt.

14.Exit the sub-object level and apply the Cloth
modifier to the Skirt object.

15.On the Object rollout click Object Properties.

16.On the Object Properties dialog, highlight the
Skirt entry in the Objects In Simulation list and
choose the Cloth option to designate the skirt
as a cloth object.

17.From the Presets drop-down list choose Cotton.

18.Click the Add Objects button and add Manny
to the simulation. Choose the Collision Object
radio button to designate the mannequin as a
collision object. Click OK to exit the dialog.

Now it’s time to simulate and see how the dress
looks.

19.On the Simulation parameters Rollout turn
Gravity off and make sure Use Sewing Springs
is on. Click Simulate Local (damped) and let
the sewing springs pull the skirt together for
a few seconds. Press the Esc key to stop the
simulation.

20.Turn off Use Sewing Springs and turn on
Gravity.

21.Run the local simulation again to snap the
seams together and to define the pleats. After
a couple of frames, press the Esc key to halt
the simulation.
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Skirt after simulation is complete



788 Chapter 7: Hair and Cloth




